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Safety Instructions

E
N

G

Follow Traffic Safety Instructions 
● Do not use the earphones while driving an automobile or riding a bicycle.  

It’s not only dangerous, but also against the law. 

● To avoid an accident, do not turn up the volume of the earphones too high while walking.

Protect your ears 
● Do not turn up the volume too high. Doctors warn against prolonged exposure to high volume. 

● Stop using the device or turn the volume down if you have ringing in your ears.

● Follow local guidelines for waste disposal when discarding packages, batteries, 
and old electronic appliances.  

● Your player is packaged with cardboard, polyethylene etc., and do not use any unnecessary materials.  

● Ambient temperature : 5°C ~ 35°C (41°F ~ 95°F) 
● Humidity : 10 ~ 75%

Please read and understand all the instructions to avoid injury to yourself and damage to the device

REC
A↔B

Do not expose to extreme
temperatures (above 35°C
or below -5°C). Do not
expose to moisture. 

Do not apply excessive
pressure to the device.
Do not drop the player.

Do not try to disassemble
and repair the device
yourself. 

Do not expose to 
chemicals such as 
benzene and thinners. 

Do not expose to direct
sunlight or heat sources. 

Do not store in dusty areas.

Do not let any foreign 
matter spill into the device. 

Do not place heavy
objects on top of the
device.

✽ Please be aware that we disclaim all responsibility for damages from loss of
saved or recorded data due to breakdown, repair or other causes.

Do not use the unit near 
any appliance that 
generates a strong 
magnetic field.

I Earphones

I Ambient operating conditions 

I Environmental Information 
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Charging the Battery 
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!

!CAUTION
RISK OF ELECTRIC SHOCK. DO NOT OPEN

The uninsulated parts inside the charger could
cause electric shock.
For your safety, do not open the case of the
charger.

Read this User Manual to prevent any problems
that may occur while using the charger.

WWWWaaaarrrrnnnniiiinnnngggg
- Use the charger away from water sources to avoid fire or electric shock.

CCCCaaaauuuutttt iiiioooonnnn
- To avoid electric shock, use the charger only with a power outlet that matches the shape of the

converter's plug.
- Make sure that the charger's plug is inserted all the way into the outlet.

A charger is supplied with your player.

Plug the charger into a wall outlet.

✻ When recharging is complete, 
“Full!” is shown in the display window.

✻ The first time the battery is charged, it will take 
approximately 4 hours.
Battery recharge time in normal operation is 
approximately 3 hours 30 minutes.

CCCCaaaauuuutttt iiiioooonnnn
- To avoid the risk of fire, do not charge longer than 12 hours.
- Do not plug several devices into the same outlet.
- Do not use a rechargeable battery or charger that is defective.
- When using the rechargeable battery for the first time or after several months of 

non-use, fully charge it first.
- Overcharging will reduce the battery life.
- The rechargeable battery is a consumable item and its capacity will decrease gradually.
- To prolong the life of your battery, use the fully charged battery until it is completely discharged, 

and then fully charge it again before use. If you charge the battery that is not completely drained, 
the battery operating time will decrease. In this case, fully cycle (fully charge and then fully discharge) 
the battery several times.

- Do not let metallic objects, such as necklaces or coins, come into contact with the terminals 
(metallic parts) of the charger and the built-in rechargeable battery. 
A fire or electric shock may result.

- Do not touch the charger with wet hands.

✍

✍

✍
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Mass Storage Device Support
● You can use the built-in 20GB hard drive to store your entire music library, 

plus use it as an external drive for your PC to store other data files.

MP3 & WMA Playback
● Your player supports playback of both MP3 and WMA. 

USB Host Function Support
● Connect a digital camera directly to the unit for easy transfer of music,

images and other data files without the need for a PC.

Image File Viewer 
● You can view JPEG images. Image files edited with Multimedia Studio can be 

viewed as slide shows.

Direct MP3 Recording
● You can convert music from CDs, cassettes, and radio into MP3 files without a PC.

USB 2.0 High Speed Data Transfer
● Maximum data speed transfer of 120 Mbps

SRS WOW Surround Sound 
● The 3D surround(SRS) feature adds spaciousness to the sound.

1.8-inch Colour TFT LCD
● You can enjoy high quality images.

Upgradable
● You can upgrade the built-in programs when available.

Please check the home page (www.samsung.com) for upgrades.

Built-in Rechargeable Li-ion Battery
● The built-in rechargeable lithium battery provides up to 10 hours✻ of play time.
✻ Time may vary depending on usage pattern. 
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Features Features

YH925 CAN E ENG  2/16/05 8:1512:0  Page 8



Components

10 11

Location of Controls
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● The capacity of the useable built-in memory is less than indicated as the internal firmware
uses a part of the memory as well.

● The appearance of the accessories shown is subject to change for product improvement 
without prior notice.

Model

Built-in memory

YH-925 GS

20GB

Mode indicator

Artist display

Track display
Elapsed track time

Album display

Remaining Time

Battery remaining indicator

Song number display

Next Track(Track Name) Indicator

Display

Player Earphones Line-In Cable

User Manual Charger

USB Cable

SELMENU

Belt Clip

USB Adapter USB Host
Adapter

Installation CD

SELMENU

LINE-IN MIC HOLD

RE
C

MIC

HOLD switch

LINE IN jack

Skip/Search button

Skip/Search button

Record button

USB Cable Connection Port

Power On/Off
Play/Pause button

Volume UP/
Scroll UP button

Earphone jack

Volume DOWN/
Scroll DOWN button

Select button

Menu button

RESET Hole

Display
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Connecting the player to your PC

12

Continued...

3 Follow the instructions in the window to complete the installation.

Before connecting the player to PC, make sure to install
Samsung Music Studio. If “Add New Hardware Wizard” appears,
press the [Cancel] button and install Samsung Music Studio.

❑ System Requirements.

● Windows XP
● Windows Media Player 10
● Internet Explorer 6.0 or higher
● Pentium 200MHz or greater

● 50MB of available hard disk
space

● CD-ROM drive
(double speed or greater)

● USB port (2.0) supported

● DirectX 8.0 or above.

NNNNooootttteeee
- Log into your PC as an administrator

(Main User) and install the supplied
software (Music/Multimedia Studio)
into using Windows 2000 or XP.
Otherwise, installation will not be
completed.

I Installing software
1 Insert the Installation CD into CD-ROM drive. 

The picture shown below appears. 
Select [Install Samsung Music Studio].

✍ 2 Select language
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Connecting the player to your PC
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properly installedproperly installed

Windows 2000 / XP: 

1) Start → Settings → Control Panel →System →
Hardware →Device Manager →Disk Drives →
Samsung YH-925 USB Device

2) Start → Settings → Control Panel →System →
Hardware →Device Manager →Universal Serial Bus
Controller →YH-925 Mass Storage Device

8 When USB driver is not installed automatically, refer to next page.

4 Use the USB adapter to connect the USB cable to the USB port on your computer.

5 Connect the USB cable to the USB cable connection port on the player, 
and then plug the charger to the power outlet.
● If you disconnect the USB cable from your PC while implementing a command or

intializing during USB driver installation, your PC may not function correctly.

7 Upon installation of the USB driver "Samsung YH-925 USB Device" will appear
in the [System Properties] → [Device Manager].

6 The USB driver is installed with a message saying that it is searching for a
new device. You may not see the display screen during installation.
Go to the device manager to check that installation has been successfully completed.

I Connecting the player to your PC with a USB cable

Charger

USB Adapter

USB Cable

PlayerPC
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Manual Installation of the USB Driver
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Manual Installation of the USB Driver

16

4 After selecting the driver and click [Reinstall driver].

5 Select [Install the software automatically] and click [Next] to finish.

Go to “Downloading File”(p21) if the USB driver is installed.
Follow these steps if the USB driver is not installed :

1 Check the device manager.
● Windows 2000/XP (Professional):

Control Panel →System →Hardware →
Device Manager 

2 Check if there is a device listed with an
exclamation point or a question mark 
(displayed as unknown device or USB
device). 

3 Double click on the device listed with an
exclamation point or a question mark.

I When an error occurs during installation of the USB driver

NNNNooootttt iiii cccceeee
- If you are using Windows 2000 and your version of Windows does not recognize the USB 

driver, please download and install the latest service pack from windowsupdate.microsoft.com 
- The installation method may vary depending on the type of PC or operating system. 

Contact your PC dealer or service center for installation information. 
- If errors occur continuously when you install the USB driver, reconnect the USB cable after 

rebooting your system.

✍

YH925 CAN E ENG  2/16/05 8:1612:0  Page 16



Disconnecting the USB cable

18 19

Formatting in PC
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1 Select [Start] → [Programs] →

[YH-925 Samsung Music Studio] in the
desktop,and then press [Recovery Utility].

2 Press the [Format Device] button.
When the format screen appears, select
the file system as FAT32 and then
press the [Start] button.

NNNNooootttteeee
- By formatting, all previously preset menus will be reset,and any pre-existing song or

data files will be erased.
- Care must be taken as formatted files can not be recovered.

● After completing the file transmission, you must disconnect the cable in the following way:

● Please close Music Studio and Multimedia Studio.

1 Double-click on the green arrow in the
taskbar on the bottom right of the window.

2 When the [ Stop a Hardware device ] message appears, 
press the [OK] button and disconnect the USB cable. 

✍

YH925 CAN E ENG  2/16/05 8:1612:0  Page 18



E
N

G

Using Recovery Utilities

20 21

The Recovery Utility can be used to recover your system in the event the 
following occurs:
● If one of the messages below appears:

- The device firmware needs repairs. Please connect to PC and repair firmware with 
recovery utility. Device will be turned off.

- The device database needs repairs. Please connect to PC and rebuild database with 
recovery  utility. Device will be turned off.

● If the message "Loading" appears and the device does not operate when you turn on the power.
● If file search does not work properly in the Menu Library.

1 Connect the player to PC.

2 Select [Start] → [Programs] → [YH-925 Samsung Music Studio ] in the desktop,
and then press [Recovery Utility].
● For more details on recovery, press [Help] to view the help.

3 Select the recovery method you want.
● See help for details on each method.

Using Music Studio

I Downloading File
1 Connect the player to PC.

2 Press the [Add] button on the upper part of Play List window to get the file you
want to Play List window.

3 Select the file you want to move to the player, and then drag and drop it to 
[Samsung YH-925] of the player or press the [Transmit to your portable device] button.

● The selected files will be downloaded to the player.

NNNNooootttteeee
- You can transmit the files from File List window to  the 

player in the same way as above.
- If you select [yes] in the [Get ID3 Tag] window during file 

download, song information (ID3 Tag) of relevant file 
will be modified to the accurate information.

- Refer to [Help] for more detailed information about using
Music Studio. 

● Music Studio is the program that enables you to download music files to the player,
and play back music files on your PC.

● Files downloaded without using Music Studio cannot be played.

1

2

✍
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Using Music Studio

I Making Album
1 Connect the player to PC.

2 Press the [To Album List] button from the Play List window to bring up the [Save 
album name] window. Enter the name of the current playlist and press the [OK] button.
● Album List window will be displayed.

3 Press the [New Album] button to select the name, basic image and album 
image of new album and then press [OK].
● Play List window for the new album will be displayed.

NNNNooootttteeee
- You can download all albums to your player by selecting albums in Album List window.
- Refer to [Help] for more detailed information about using Music Studio.

● Albums downloaded to the unit can be viewed at [Library] → [Playlists]
on the menu.

✍

Using Music Studio

1 Insert the CD containing the music for conversion into the PC.

2 Press the [To CD-ROM Mode] button in the File List window.

3 When [Match] window appears, press the [Accept Match] button.
● Information of tracks on the CD will be displayed.

4 Select the file to convert, and then press the [CD Ripping] button.
● The selected file will be converted to an MP3 file and then saved in the 

[My Music] folder of the C drive.

NNNNooootttteeee
- Right-click at the top of Music Studio and move to [Options] → [File Conversion Settings] →

[Format] to change conversion settings.
- Refer to Help for more information.

I Converting Audio Files

✍
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Using Music Studio

I Uploading recorded File

1 Connect the player to PC.

2 Press the [Importing recorded file to PC] button in Portable Device window.

3 Select the folder to upload, and then press the [OK] button.

4 If a warning message window appears, press the [OK] button.
● Note that the recording file in the PC will be automatically deleted if you upload the 

recorded file to PC.

NNNNooootttteeee
- Refer to [Help] for more detailed information about using Music Studio.

✍

To View Help on Music Studio 

After executing Music Studio, click the       button on the upper part of screen
or press the F1 key.
● Help will appear. 

Move the arrow to the top of Music Studio and right click on the mouse. 
The following selection window will appear. 
● Click on Help and the Help window will appear.

NNNNooootttteeee
- Music recognition technology and related data are provided by Gracenote and Gracenote

CDDB® Music Recognition ServiceSM. 
- CDDB is a registered trademark of Gracenote. The Gracenote logo and logotype, 

the Gracenote CDDB logo and logotype, and the "Powered by Gracenote CDDB" logo are 
trademarks of Gracenote. Music Recognition Service and MRS are service marks of
Gracenote.

?

✍
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Installing Multimedia Studio
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● Multimedia Studio is a program that supports image editing, video playback and format
conversion, and multimedia album creation.

3 Follow the instructions in the window to complete the installation.
1 Insert the installation CD into the CD-ROM drive.

Select [Install Multimedia Studio].

2 Select language
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Using Multimedia Studio
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GI Editing Images

1 Select the folder containing images to edit from the directory window at the
upper left-hand section of Multimedia Studio.
● The saved files will be displayed in the file list window on the right.

2 Select the image to edit.
● The selected image will be displayed in the [Preview image] window.

3 Press the [Edit Img] button.
● From the [Picture editor] window, you can perform functions like editing wallpaper images,

editing layers, inserting clip arts, making frames and other various editing functions.

NNNNooootttteeee
- Refer to Help for more information.

● Run Multimedia Studio from on the Desktop.

I Sending images

2 Select the image(s) to send to the player.

3 Select [File] → [Export images to device] at the top of the Multimedia Studio menu.

4 Select the device connected to PC from the [Select device] screen, 
and then press the [OK] button.

1 Connect the player to PC.

● Files downloaded without using Multimedia Studio cannot be viewed on the screen.

✍
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Using Multimedia Studio

30

5 Set the size and path of the image at the [Resize images] window and then
click the [OK] button.
● The image will be sent to the selected device.

● The sent image can be viewed from [PhotoAlbum] → [Albums] on the player.

● The optimal image size for viewing on the unit is 160 x 128. 
Please adjust the image size if the image does not display correctly on the player.

NNNNooootttteeee
- Path refers to the location or folder where the converted image(s) will be saved to on your PC.
- Image files saved in the player can be deleted by selecting [File] → [Delete images from device].
- Refer to Help for more information.

✍

I Making Albums for Slide Shows

2 Press the [Edit Alb] button at the top of Multimedia Studio.
● The [Making New Album] window will be displayed.

3 Select [Making Album for the use of PPL] and
then press the [OK] button.
● The [PPL Album] window will be displayed.

4 Press the [Add Image] button at 
the top of the [PPL Album]
window to select the image to edit.
● If multiple images are selected, each

image will be displayed for 5 seconds.

5 Press the [Add Music] button to add background music.
● Add BG Music: Images change every 5 seconds while the

selected music is played.

1 Connect the player to PC.

● Albums created from [Making Album for the use of PPL] can be viewed as slide shows 
on the player.

NNNNooootttteeee
- To add a copyright protected audio file, which can be played on the player, 

select [Add Music] → [Add BG Music] → [Add from Device] and select the 
desired file on the connected player. 

- Copyright protected audio files added from the player are marked DEVICE, 
and cannot be played in the [PPL Album] window.

✍
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Using Multimedia Studio

32

NNNNooootttteeee
- Select [Delete Album From Device] to delete ppl file saved in the player.

- Refer to [Help] for more detailed information 

I Capturing Video

1 Press the [Capture] button at the top of the Multimedia Studio menu.
● The Media Player screen will be displayed.

2 Click [Menu] → [Open] on your PC and select the video to play.
● The selected video will be played.

7 Select the directory to save to in the save window
and press the [Save] button.
● The edited album will be saved in the selected directory.

8 Select [Album] → [Export] → [Export to Device]
at the top of the [PPL Album] window to send 
the saved ppl file to the device.

9 Enter the album name at the [Select device] screen and then press the [OK] button.
● The ppl file will be sent to the selected device.
● The sent ppl file can be viewed from [Photo Album] → [Slide Show] on the player.

6 Press the [Save] button at the top of the [PPL Album] window when album 
editing is complete.

✍

● The Multimedia Studio software allows you to capture a still frame from a video file and save it
as a picture, then transfer it to the YH-925.
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Using Multimedia Studio

34

Run Multimedia Studio and press the Help button at the top of the screen.

● Help will be displayed.

3 Press the      [Capture] button and then press the      [Capture] button when
the image you want to capture appears.
● The selected image will be captured.

4 Press the [Save] button.
● Save This captured image: saves the currently selected image.
● Save All captured images: saves all captured images.

5 Select the directory to save to from the [Save As] window and press the
[Save] button.
● The selected image will be saved.

NNNNooootttteeee
- Video playback and conversion codecs are not provided. It is recommended that you 

use codecs of latest versions.
- Refer to [Help] for more detailed information
- The device will only play back still images. It will not play back video.

✍

1 2

1

2

YH925 CAN E ENG  2/16/05 8:1612:0  Page 34



Playing music 

36 37

Hold Feature
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Activate             on the main unit.
● When you activate the HOLD switch, a "         " appears on the display.

Use the Hold feature to lock and disable all buttons. The Hold feature is useful to prevent your
Samsung player from being accidentally turned off or on, or to ensure uninterrupted playback.

HOLD

I Starting Point
While playing a music file, press the SEL button at
the beginning of the loop you want to set.
● A ↔ appears in the display. 

Press the SEL button again to set the end of the loop.
● A ↔ B appears in the display. 

The loop is played repeatedly.

I Ending Point

NNNNooootttteeee
- Press the SEL button to cancel the loop.

NNNNooootttteeee
- Press and hold the SEL button in Now Playing mode while a file is playing to display the current Playlist. 
- In the Playlist, use the SCROLL UP/SCROLL DOWN buttons to move to a track, and press the 

√» button to play the selected track.

I Playing Music

I Pausing Music

Turning Power On and Off
● Power On: Press and hold the √» button to turn on the power.
● Power Off: Press and hold the √» button to turn off the power.

Select Now Playing in the menu.
● Playback starts automatically.

Press the √» button to pause
playback.
● While in Pause mode, briefly press

√» again to resume playback.

Make sure the player is fully charged and the earphones are connected.

PLAY

Now playing

Press the VOLUME UP or DOWN button to
adjust the volume from 0 to 40.

I Adjusting the Volume

Loop Repeating

✍

✍
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Menu Mode
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Press the MENU button to switch to Menu mode.
● Use the SCROLL UP/SCROLL DOWN buttons to select the menu item you want, 

and then briefly press the SEL button.

NNNNooootttteeee
- In Menu mode, press the Menu button to exit from the submenu you are in.

NNNNooootttteeee
- VBR (Variable Bit Rate) File: An MP3 file that has varying compression ratios.
- When playing a VBR file, even if you press the         button within 5 seconds after the start of playback, 

the previous song may not be played.
- The actual play time and the time displayed on the main unit may differ for VBR files.

● During playback, press and hold the     ,        buttons to forward or reverse search the cur-
rently playing file.

I Searching for Specific Parts in PLAY Mode

● During playback, briefly press the         button to play the next track in the playlist.

● Press the         button within 5 seconds after playback starts to move to and play the 
previous track. Press the         button after 5 seconds to play the current track from the
beginning.

I Searching for Music Files in PLAY Mode

● While in pause mode, press the     ,        buttons to move to the previous or next track in the
playlist and play it automatically.

I Searching for Music Files in PAUSE Mode

✍

✍

● Now Playing: Display the song currently playing.
● Library: Search and select music to play.
● Photo Album: View saved image files or slide shows
● USB Host : Transfer files saved in the unit to external devices or transfer 

files saved in external devices to the unit.
● Settings: Change the settings.

Photo Album
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Browsing Your Music
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● Genres: Shows the song genre from the ID3 tag information stored in the music file.
● Press the √» button on the desired genre name. 

All song titles corresponding to the genre name will be played.
● If you select an genre name, song titles corresponding to that genre will be displayed. 

You can use the SCROLL UP/DOWN buttons to choose a song, and then press the 
SEL button to play the selected song.

● Tracks: Shows the song title from the ID3 tag information stored in the music file.
● You can use the SCROLL UP/DOWN buttons to move, and then press the SEL button 

to play the selected song.

In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select the Library, 
and  press the SEL button.

● Artists: Shows the artist name from the ID3 tag information stored in the music file. 
● Press the √» button on the desired artist name. 

All song titles corresponding to the artist name will be played.
● If you select an artist's name, song titles that correspond to the name will be displayed. 

You can use the SCROLL UP/DOWN buttons to move, and then press the SEL button 
to play the selected song.

● Albums: Shows the album title from the ID3 tag information stored in the music file.
● Press the √» button on the desired album name. 

All song titles corresponding to the album name will be played.
● If you select an album name, song titles corresponding to that album will be displayed. 

You can use the SCROLL UP/DOWN buttons to choose a song, 
and then press the SEL button to play the selected song.

I Searching for and Selecting Music Files

Artists

Library

Albums
Tracks
Genres
Playlists

Enya-Braveheart Theme

All Tracks

Jack Jhonson-Inaudible
Jhon Philip Sousa-US
My Heart Will Go On
Old Time Rock and Roll

All Tracks

Artists

Beach Boys
Beatles
Billy Joel
Bachman Turner Ove

Artists

Library

Albums
Tracks
Genres
Playlists

Turning the Tide

Everyday I Dream

Waking Up Is Easy
Every Dream

Albums

Building Birdages

Artists

Library

Albums
Tracks
Genres
Playlists

009 5tion-Sorry

Tracks

027 Cami-You can it
073 U-groove
015.everything me

Artists

Library

Albums
Tracks
Genres
Playlists

Blues

Genres

Other
Pop
Rock

Takin Care of Business

Blues
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1 Select a title in the Playlists, and press and hold the SEL button.
● Move to Play Options screen.

2 In the Play Options, use the SCROLL UP/SCROLL DOWN buttons to select the
desired play option, and press the SEL button.

● Add To Mobile Playlist:
The selected title will be moved to Mobile Playlist.

● Cancel: Go back to the previous screen.

I Play Options (Playlists)

1 In the Library, use the SCROLL UP/SCROLL DOWN buttons to select Playlists
and then press the SEL button.

2 Select the playlist that you want to play, and then press the SEL button.
● Saved files will appear in the selected playlist. 

I Selecting a Playlist

3 Press the SEL button on the desired file.
● The selected file will be played.

● Play: The selected title will be played.
If you select [Play] in Artist, Album and Genre, all titles corresponding to Artist, 
Album and Genre will be played.

● To Mobile Playlist: The selected track is added to the Portable Playlist.

● Cancel: Go back to the previous screen.

1 Select Artist, Album, Track, Genre, and press and hold the SEL button.
● Move to Play Options screen.

2 In the Play Options, use the SCROLL UP/SCROLL DOWN buttons to select the
desired play option, and press the SEL button.

I Play Options (Artists, Albums, Tracks, Genres)

NNNNooootttteeee
- Mobile Playlist is a play list always present in the unit. Songs stored in the unit can be easily

added to or deleted from Mobile Playlist.

✍

Enya-Braveheart Theme

Tracks

Jack Jhonson-Inaudible
Jhon Philip Sousa-US
My Heart Will Go On
Old Time Rock and Roll

Play
Add To Mobile Playlist
Cancel

Artists

Library

Albums
Tracks
Genres
Playlists

Mobile Playlist

Playlists

Line-in Recordings
Clear tracks

Mobile Playlist

Jack Jhonson-Inaudible
Enya-Braveheart Theme

Enya-Braveheart Theme

Mobile Playlist

Add To Mobile Playlist
Cancel
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jack and the line out jack of your external audio device.

NNNNooootttteeee
- If the battery is not sufficiently charged, the player will not completely encode the file.
- Adjust the volume of the external audio source to a suitable level and encode it.

If the volume level is too high, the sound quality may be poor.

LINE-IN MIC HOLD

2 Slide the REC switch to start recording.
● The music currently played on the external device will be saved as an MP3 file.

3 Slide the REC switch in the opposite direction to stop recording. 
● Recording stops and the file is created.
● Files are recorded and renamed Line-in0001.mp3, Line-in0002.mp3, and so on.
● MP3 files are automatically added to your Library.

✍

Your player can be to used to record directly from any external audio source such as a CD player,
cassette player, home stereo or radio.

Browsing Your Music

44

1 Select a Voice file in the Voice Recordings, and press and hold the SEL button.
● Move to Play Options screen.

2 In the Play Options, use the SCROLL UP/SCROLL DOWN buttons to select the
desired play option, and press the SEL button.

● Play : The selected title will be played.

● Delete : The selected title will be deleted.

● Cancel : Go back to the previous screen.

I Play Options (Voice Recordings)

1 In the Library, use the SCROLL UP/SCROLL DOWN buttons to select Voice
Recordings, and then press the SEL button.
● Recorded voice file will appear.

2 Press the √» button or SEL button on the desired file.
● The selected file will be played.

I Searching for and Selecting Voice Files

Albums

Library

Tracks
Genres
Playlists
Vioce Recordings

Voice0001

Vioce Recordings

Voice0002
Voice0003

Voice0001

Vioce Recordings

Voice0002
Voice0003

Play

Delete
Cancel
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Viewing Slide ShowViewing Image Files

NNNNooootttteeee
- Please refer to “Sending Images” under “Using Multimedia Studio” to send images to the player.

1 Press the MENU button.
In the Menu, select Photo Album and press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Albums.

3 Use the SCROLL UP/SCROLL DOWN buttons to move to the desired image
file and press the SEL button.
● The selected image file will be displayed.
● While viewing the image file, press the MENU button to move to the previous screen.

Albums

✍

Albums

Albums

Photo Album

Slide Show
Upload Album

¿Ωº∫≥Ï¿Ω

sky.jpg

Albums

sea.jpg
land.jpg

1 Press the MENU button.
In the Menu, select Photo Album and press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons  to select Slide Show.

3 Use the SCROLL UP/SCROLL DOWN buttons to move to the desired file and
then press the SEL button.
● The selected slide show will be displayed.
● While viewing the slide show, press the SCROLL UP/SCROLL DOWN buttons 

to adjust the background music volume.
● While viewing the slide show, press the MENU button to move to the previous screen.

NNNNooootttteeee
- Slide show files can be created and edited in Multimedia Studio. 

For details, see “Using Multimedia Studio.”
- Music is played only if music was attached at the time of album editing.
- Select [Menu] ➔ [Photo Album] ➔ [Upload Album] to view image files transferred from external

devices to the unit.

✍

Albums

Photo Album

Slide Show
Upload Album

National Parks.ppl

Slide Show

Patriotic.ppl
Photo Album

Photo Album
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1 Use the USB cable to connect the unit and the USB host adapter.
● Plug the charger into a wall outlet.

2 Use the external device USB cable to connect the external device
and the USB host adapter.

3 Press the MENU button to switch to Menu screen. 
Select USB Host and then press the SEL button.

4 Use the SCROLL UP/SCROLL DOWN buttons to move to [YES] and then 
press the SEL button.
● The External Device screen will be displayed.

I Connecting an External Device

Player

External Device

USB Cable (External Device)
USB Host Adapter

USB Cable (Player)

Charger

Please connect a 
slave device

YES
NO

Device

[MISC]
[The Volume SettingF
[VOICE]

√» Host

[DCIM]

1 At the External Device screen, move to a file to transfer to the Player.
● SCROLL UP/SCROLL DOWN : Moves up and down.

● SEL : Moves to a subfolder.

2 Press and hold the SEL button to bring up the pop-up window. Move to [Copy],
and press the SEL button.
● The selected file will be transferred to the unit. Do not disconnect the unit from the 

external device during file transfer.
● To view the transferred file, press the √» button to move to the Host screen and see the

[UPLOAD] folder.
● Uploaded image files can be viewed at [Menu] ➔ [Photo Album] ➔ [Upload Album].

I Transferring Files from an External Device to the Player

Do not disconnect
Device

Device

√» Host

[DCIM]
[MISC]
[The Volume SettingF
[VOICE]

[DCIM]

√» Host

[100NIKON]

[100NIKON]

DSCN1002.JPG
DSCN1003.JPG
DSCN1004.JPG

√» Host

DSCN1001.JPG

Copy

Delete
Cancel

YH925 CAN E ENG  2/16/05 8:1612:0  Page 48



51

E
N

G

Using USB Host

50

Shuffle and Repeat Playback

1 At the External Device screen, press the √» button.
● The Host screen will be displayed.

2 Move to a file to transfer to the external device.
● SCROLL UP/SCROLL DOWN : Moves up and down.

● SEL : Moves to a subfolder.

3 Press and hold the SEL button to bring up the pop-up window. 
Move to [Copy], and press the SEL button.
● The selected file will be transferred to the external device.

Do not disconnect the unit from the external device during file transfer.

I Transferring Files from the Player to an External Device

Do not disconnect
Device

[My Music]

BrownEyes‚.mp3
GOD1.mp3
GOD2.mp3

√» Device

1TYM_OneLove.mp3

Copy

Delete

Cancel

Host

[tmp]
[UPLOAD]
[Program Files]

√» Device

[My Music]

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select
Settings, and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Repeat.

3 Press the SEL button to choose Repeat Off, One, All or Shuffle.
● Select the desired mode, and then press the MENU button to go to the main menu.

● Off: Select this to listen to songs in the current playlist one 
at a time in the given order.

● One (       ): Select this to repeatedly play just one track.

● All (       ): Select this to repeatedly play all tracks in the current playlist.

● Shuffle (       ): Select this to play all stored tracks in random order.

Settings

EQ-Off
SRS Settings
Record Settings
Backlight-5sec

Repeat-Off

YH925 CAN E ENG  2/16/05 8:1612:0  Page 50



53

SRS Settings

E
N

G

Equalizer Settings
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1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select
Settings, and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select EQ.

3 Press the SELECT button until the desired mode appears.
● Select the desired mode, and then press the MENU button

to go to the main menu.
Off ➔ Jazz ➔ Classical ➔ Pop ➔ Rock ➔ Bass boost ➔ 

WOW ➔ SRS ➔ TruBass

NNNNooootttteeee
- is a trademark of SRS Labs, Inc. 

WOW technology is incorporated under license from SRS labs, Inc..  
- Please adjust the volume to a suitable level, as the volume may increase in the SRS setting.
- This unit supports sampling frequencies of 32KHz, 44.1KHz or 48KHz.

● WOW: This feature allows you to enjoy the SRS and Trubass features simultaneously.

● SRS: You will hear 3D Stereo sound.

● TruBass: This is a bass boost feature that adds fullness to the sound.

✍

Settings

SRS Settings
Record Settings
Backlight-5sec

Repeat-Off
EQ-Off

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select
Settings, and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select SRS settings, 
and then press the SEL button.

3 Use the SCROLL UP/SCROLL DOWN buttons to select SRS Level, 
TruBass Level, Focus Level and Optimum, and then press the SEL button to
make the desired SRS Settings.
● Complete the desired setting, and then press the MENU button to go to the main menu.
● SRS, TruBass, Focus Level: The level for SRS, TruBas and Focus can each be set 

within the range of 0 to 10.
● Optimum: It optimizes the SRS function according to the device connected.

Use the SEL button to move to the connected device.  
Earphone ➔ Headphone ➔ Speaker ➔ Carpack

NNNNooootttteeee
- SRS settings are available only if WOW, SRS, or TruBass are selected in the EQ menu.

✍

Settings

Record Settings
Backlight-5sec

Repeat-Off
EQ-Off

SRS Settings

FocusLavel - 8
Optimum - Earphone

SRSLevel - 8
TruBassLavel - 8

SRS Settings
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1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select
Settings, and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Record Settings, 
and then press the SEL button.

3 Use the SCROLL UP/SCROLL DOWN buttons to select SamplingRate and Bit Rate,
and then briefly press the SEL button to make the desired recording setting.
● Complete the desired setting, and then press the MENU button to go to the main menu.
● Sampling Rate: Each time the Select button is pressed, the selection toggles  

between 32KHz and 44KHz.
● Bit Rate: Each time the Select button is pressed, the selection changes as follows: 

96 ➔ 128 ➔ 160Kbps.
● Selecting a higher bit rate results in better quality sound, but uses more memory space.

NNNNooootttteeee
- Voice can be recorded only at 8KHz 32kbps.

✍

Settings

Record Settings

Repeat-Off
EQ-Off

Record Settings

SamplingRate- 44khz

Bit Rate - 128kbps
SRS Settings

Backlight-5sec

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Backlight.

3 Press the SEL button until the desired Backlight
On-Time appears. 
● Off, 3, 5, 10, 15, 30seconds and Always are available for 

Backlight-On Time.

Settings

Record Settings

Repeat-Off
EQ-Off
SRS Settings

Backlight-5sec

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Contrast.

3 Press the SEL button until the desired screen 
contrast appears.
● The setting range of the contrast, which adjusts the 

contrast of the screen, is 0 to 6.

Settings

Backlight-5sec

EQ-Off
SRS Settings
Record Settings

Contrast-3

Contrast Settings
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Fader Effect

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select LCD Off Time.

3 Press the SEL button until the desired LCD power-off time appears.
● 30sec →1min →5min →10min →15min →Always
● If the selected time elapses while playing music, the screen switches to power save mode.

In power save mode, the music continues to play but the music information is not 
displayed on the screen.

● Press the √» button in power save mode to return to the normal playback screen.

Settings

Contrast-3

SRS Settings
Record Settings
Backlight-5sec

LCD Off Time-30sec

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Fader Effect, and then
press the SEL button.

3 Use the SCROLL UP/SCROLL DOWN buttons to select Fade Type, Curve Type,
and Duration Time, and then briefly press the SEL button.
● Complete the desired setting, and then press the MENU button to go to the main menu.
● Fade Type : Each time the SEL button is pressed, the selection changes as follows :

- Fade Off: Music is played back at the volume level you set. 
- Fade In: Volume gradually increases only when playback starts.
- Fade Out: Volume gradually decreases at the end only.
- Fade In/Out: Volume gradually increases when playback starts and gradually 

decreases at the end.
● Curve Type : Each time the SEL button is pressed, the selection changes as follows :

- Linear: The speed at which the volume of music increases or decreases is fixed. 
- Slow: The speed at which the volume of music increases or decreases is slow.
- Fast: The speed at which the volume of music increases or decreases is fast. 

● Duration Time : Each time the SEL button is pressed, the selection changes as follows :
3 ➔ 5 ➔ 10 ➔ 15sec

Fader Effect

Fade Type-Off
Curve Type-Linear
Duration Time-5sec

Settings

LCD OFF Time-30sec

Record Settings
Backlight-5sec
Contrast-3

Fader Effect
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Restoring Default Settings

Language Settings

Power Off Settings

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Auto Power off.

3 Press the SEL button until the desired power-off
time appears.
● Select the desired power-off time, and then press the

MENU button to go to the main menu.
OFF ➔ 30sec ➔ 1min ➔ 5min ➔ 10min ➔ 15min.

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Language.

3 Use the SCROLL UP/SCROLL DOWN buttons to 
select the desired language, and then press the 
SEL button.
● English → Korean → Japanese →  S.Chinese → T.Chinese →

French → German → Italian → Spanish → Russian
● The Menu Screen will appear in the language you set.

Settings

Auto Power Off-5min

Contrast-3
LCD OFF Time-30sec
Fader Effect

Language

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Reset, 
and then press the SEL button.
● If you select YES, all selected settings will be restored to the default setting. 

Volume = 20
Repeat = Off
EQ = Off
Backlight = 5sec
Contrast = 3

Default Settings

Reset all default
Settings?

NO
YES

Settings

Language

LCD OFF Time-30sec
Fader Effect
Auto Power Off-5min

Reset

Player Information

2 Use the SCROLL UP/SCROLL DOWN buttons to select About, 
and then press the SEL button.
● If you select About, you can check the total number of tracks, total capacity, 

available capacity and software version information.

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

Settings

Reset

Fader Effect
Auto Power Off-5min
Language

About

About

Tracks 127
18.6GB
18.4GB

0.23

Capacity
Available
Version

Settings

Fader Effect

Backlight-5sec
Contrast-3
LCD OFF Time-30sec

Auto Power Off-5min
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Troubleshooting

One of the messages below appears:
“The device firmware needs repairs. Please connect to PC and repair firmware with recovery 
utility. Device will be turned off.” or “ The device database needs repairs. Please connect to PC 
and rebuild database with recovery  utility. Device will be turned off.”

The message "Loading" appears and the device does not operate when you turn on
the power.
File search does not work properly in the Menu Library.
● Refer to “Using Recovery Utilities”

The player doesn't work. There is nothing showing on the display panel.
● Reset the Player
● Connect the charger.
● Make sure the Hold switch is in the off position.

There is no sound even if I press the Play button in Music mode.
● Check if there are MP3 or WMA files on the player.
● Non-playable file formats (e.g. MPEG1 LAYER 1 file) cannot be played.
● Files that have been downloaded without using the Music Studio cannot be played.

I cannot download files.
●  Check the battery's power level.
●  Check if the driver is installed correctly on your PC.

Reinstall the software from the installation CD. 
●  Check the USB connection between the player and your PC.
●  Check if there is the “unplug/eject” or “Safely Remove Hardware” icon located in your icon 

tray at the bottom of your screen.

Cannot view image files.
●  Files downloaded without using Multimedia Studio cannot be viewed on the screen.

Troubleshooting

The Backlight is off.
● Please check the Backlight settings.
● Backlight is automatically disabled for longer playback in case of low battery power.

The playback time display during playback does not seem right.
● Check if you are not playing a VBR (Variable Bit Rate) file. VBR files are only partially

supported.

The LCD window is too dark.
● Check the contrast in the Menu.
● Please check if the player is in power save mode.

During playback, some unknown characters are displayed on the display panel. 
● Unsupported languages will be indicated by an asterisk ( ✻ ).

A "/Noartist/Noalbum" file path appears on the playback screen in place of the 
selected music file's song title.
●  There is no ID3 tag information for the music file. Edit the song title, artist, and album 

information of the song.

It takes a long time when I search songs by Song Title, Artist, or Album.
● If there are many music files on your player, it may take longer to read them .
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SpecificationsUSB HOST Compatible

●  You can transfer images from the cameras listed below to your YH-925 for storage. 
●  The following is a list of cameras that are compatible with YH-925 USB Host function.
●  This list may change with firmware upgrade.

Digimax-420, Digimax-400

Finepix-A340, Finepix-F450
Finepix-F610

PhotoSmart 945

Dimage Z1

Coolpix 4200

Lumix-FZ20

Optio-S40

300-Digital

IXUS-500, Digital IXY-500
Powershot-G6

DX-7630, DX-7430

Samsung

Fuji

HP

Minolta

Nikon

Panasonic

Pentax

Olympus

Canon

Kodak

Digital Camera

Device Manufacturer Model Number

Model YH-925
Internal Memory Capacity 20GB

Built-in Rechargeable Battery Capacity 900mAh
Voltage 3.7V (Li-ion Rechargeable Battery)

Dimensions/Weight 1.96”X 0.54” X 3.47”/2.98oz
Case Aluminum/Plastic

File Transfer Speed Max. 120Mbps
Signal to Noise Ratio 85dB with 20KHz LPF(based on 1KHz OdB)

Earphone Jack Output Power 12mW/CH (16Ω)
Output Frequency Range 22Hz~20KHz

Temperature Range -5~ +35°C(23~95F)
File Support MPEG1/2/2.5 Layer3(8Kbps ~ 320Kbps, 8KHz ~ 48KHz)

WMA (48Kbps ~ 192Kbps, 8KHz ~ 48KHz)

The product unit accompanying this user manual is licensed under certain 
intellectual property rights of certain third parties. This license is limited to private 
non-commercial use by end-user consumers for licensed contents. No rights are 
granted for commercial use. The license does not cover any product unit other than 
this product unit and the license does not extend to any unlicensed product unit or
process conforming to ISO/IEC 11172-3 or ISO/IEC 13818-3 used or sold in 
combination with this product unit. The license only covers the use of this 
product unit to encode and/or decode audio files conforming to the ISO/IEC 11172-3 or
ISO/IEC 13818-3. No rights are 
granted under this license for product features or functions that do not conform 
to the ISO/IEC 11172-3 or ISO/IEC 13818-3.
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Samsung Limited Warranty
Samsung Electronics Canada Inc. (SECA),
warrants that this product is free from defective material and workmanship.

SECA further warrants that if this product fails to operate properly within the 
specified warranty period and the failure is due to improper workmanship or 
defective material SECA will repair or replace the product at its option.

All warranty repairs must be performed by a SECA authorized service 
centre. (The name and address of the location nearest you can be obtained by 
calling toll free 1-800-726-7864 or visiting our web site at www.samsung.ca)

Labour Parts
one (1) year (carry-in)                one (1) year

On carry-in models, transportation to and from the service centre is the 
customer’s responsibility.                                                                                      
The original dated sales receipt must be retained by the customer and 
is the only acceptable proof of purchase. It must be presented to the 
authorized service centre at the time service is requested.

Exclusions
This warranty does not cover damage due to accident, fire flood and/or 
other acts of God; misuse, incorrect line voltage, improper installation, 
improper or unauthorized repairs, commercial use, or damage that occurs in
shipping. Exterior and interior finish, lamps and glass are not covered under this
warranty. Customer adjustments which are explained in the instruction manual
are not covered under the terms of this warranty. This warranty will automatical-
ly be voided for any unit found with a missing or altered serial number. This war-
ranty is valid only on products purchased and used in Canada.

MEMO
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